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本文件供已购买 SCIEX 设备的客户在操作此 SCIEX 设备时使用。本文件受版权保护，除非 SCIEX 书
面授权，否则严禁对本文件或本文件任何部分进行任何复制。

本文中所介绍的软件属于许可证协议项下提供。除许可证协议中特别准许的情况外，在任何媒介上复
制、修改或传播本软件均为违法行为。此外，许可证协议禁止出于任何目的对本软件进行分解、反向工
程或反编译。质保条款见文中所述。

本文件的部分内容可能涉及到其他制造商和/或其产品，其中可能有一些部件的名称属于各自所有者的
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SCIEX 的质量保证仅限于在销售或为其产品发放许可证时所提供的明确保证，而且是 SCIEX 的唯一且
独有的表述、保证和义务。SCIEX 不作任何其他形式的明确或隐含的质量保证，包括但不限于特定目的
的适销性或适用性的保证，不论是法规或法律所规定、还是源于由贸易洽谈或商业惯例，对所有这些要
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成的间接或结果性损失。
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本文件针对软件的部分工具和可用功能提供了教程概述。 但是，本文件不对每个可用操作提供
详细描述，只是对软件可处理的一些常用工作流做出了解释。

机构

尽管有些功能和操作是专用于特定应用和工作流的，但是大部分还是通用的，而且常常用于研
究定性数据。 本节中对软件概念进行简要介绍，并对部分最常用的基础操作做了描述。 随后
的章节描述了特定工作流程的方法并会用到随软件提供的样本数据文件。

样本文件通过 SCIEX OS DVD 分发，位于文件夹 Extras/Example Project 中。将整个项目复
制到计算机上的以下文件夹中：D:\SCIEX OS DATA。下述样本文件用于本教程所用的示例中：

• Bromocrip_IDA-DBS alone_T=1.wiff

• Bromocrip_IDA-DBS in plasma_T=0.wiff

• Bromocrip_IDA-DBS in plasma_T=1.wiff

• DataSET61.wiff

• DataSET62.wiff

• DataSET63.wiff

• DataSET64.wiff

• DataSET65.wiff

• DataSET66.wiff

• RP_digests. wiff

• RP_Intact.wiff

• Bromocriptine.mol

溴隐亭文件来自于对鼠肝微粒体温育的负极性 IDA 分析。 Bromocrip_IDA-DBS alone_T=1.wiff
是在一小时点处获得的，而其他两个是在零小时和一小时时间点处上升为等离子体。
Bromocriptine.mol 文件中包含溴隐亭的分子结构。 DataSET61 至 DataSET66 文件是关于氯
雷他定及其杂质的。 不同数据集代表不同的浓度水平。 RP_Intact.wiff 文件来自于对完整肌
红蛋白的分析。 RP_digests.wiff 文件来自对消化后的肌红蛋白的分析。

选项

软件可提供很多用于微调命令表现方式的选项。 如图 1-1 所示，有些可提供一个复选框，允
许对话框只在 Shift 键被按下时才显示。 这可以消除不要求更改参数时与对话框交互的需要。
这些命令所在菜单中含有一个向上的箭头。
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图 1-1 选项

窗格

当软件使用窗口来显示和接收信息时，基本用户界面组件就是窗格。 一个窗口中可能含有一个
或多个窗格，但是一次只能有一个窗格处于活动状态。 窗格接收来自菜单和工具栏的命令。
菜单和工具栏提供操作窗格或窗格内所含数据的方式。

窗格内可能含有各种图，如：质谱图和色谱图、热图，或各种表格以及更专业化的视图。 典型
的处理操作既可以创建用于显示信息的窗格，也可以处理窗格内显示的数据。 每个窗格都含有
通用的单窗格和双窗格工具。 大部分窗格都有特定于窗格类型的附加工具。 通过附加工具可
获取更多通用命令。

常见窗口示例如图 1-2 所示。 这个窗口中含有两个窗格，其中活动窗格，即：色谱图，可通
过彩色边框和工具栏来识别。
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图 1-2 窗口内的窗格示例

常见窗格操作总结见通用窗格工具栏和双窗格工具栏。 特定窗格操作总结见图。

通用窗格工具栏

单击图标以使用通用单个窗格操作。

表 1-1 通用窗格工具栏图标

名称（工具提示）图标

删除窗格

展开活动窗格填充窗口

隐藏窗格

隐藏所有其他窗格

显示当前隐藏的所有窗格

删除所有其他窗格（按住 Ctrl 键，可只删除该窗格之后的窗格）
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注意： 主菜单栏下面的主工具栏中还有可用的类似图标。 单击主工具栏中的任一图标与单
击活动窗格中的图标对活动窗格具有相同的作用。 如果活动窗格已重调大小，且有些图标已
不见，那么该工具栏非常有用。

删除窗格

如果有多个窗格打开，则应通过这个图标删除相应窗格。如果只有一个窗格打开，则该图标不
可用。

展开活动窗格填充窗口

通过这个图标扩大窗格并填充整个窗口，或将窗格恢复至其原始大小。 如果该窗口包含多个窗
格，那么这个图标会暂时聚焦于其中之一。

对于每一个窗格会有一个独立的选项卡出现在窗口顶部。 通过单击恰当的选项卡来在窗格之间
切换。

注意： 如果窗格的标题较长，那么可能不是所有的选项卡都可见。 使用选项卡右面的箭头
按钮来滚动这些选项卡。 再次单击图标可返回原视图，显示所有窗格。

图 1-3 展开窗格示例

隐藏窗格

通过这个图标可隐藏相应窗格，这样窗口内的其他窗格可填充可用空间。 如果用户想查看一个
窗格子集，但不想永久删除其他窗格，该图标非常有用。

隐藏所有其他窗格

通过这个图标隐藏除相应窗格以外的其他全部窗格。 具体效果与单击“展开活动窗格填充窗
口”图标的效果类似，这是因为这两种情况下都只保留了相应的窗格并填充了可用空间。当接
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下来再创建另一窗格时，不同之处就很明显了。 在展开窗格案例中，新窗格成为活动窗格并填
充可用空间。 在隐藏窗格案例中，两个窗格（原活动窗格和新窗格）都可见。

显示当前隐藏的所有窗格

通过这个图标显示已隐藏的所有窗格。

删除所有其他窗格

如果未按下 Ctrl 键，那么这个图标将删除窗口内除相应窗格以外的所有窗格。清除和再处理
样本时，该选项很有用。当前隐藏的窗格也会被删除。

如果按下 Ctrl 键，那么只有相应窗格后面的窗格才会被删除。当有很多窗格打开，但是只要
求特定数量的初始窗格时，该选项很有用。这种情况下，隐藏窗格不会被删除。

双窗格工具栏

拖动图标，使用双窗格操作（是否可用取决于窗格类型）。 源窗格是指含有选定图标的窗格，
目标窗格是第二个窗格。

表 1-2 双窗格工具栏图标

名称（工具提示）图标

拖放以重新安排窗格。

拖动至另一图，以将活动数据添加至另一图的活动数据中。（按住 Ctrl 键，将
数据添加至另一图内的所有数据集中。）

拖动至另一图，以将活动数据从目标图的活动数据中减除。（按住 Ctrl 键，从
目标图的所有数据集中减除。按住 Shift 键，以保持负值。）

拖动至另一图，以在目标图内叠加活动数据。 （按住 Ctrl 键，叠加所有数据
集，而不仅仅是活动数据。）

拖放以重新安排窗格

这个图标位于各个窗格的右上角，可用于改变窗格的相对位置。 单击一个窗格中的图标，然后
将其拖动至第二个窗格的顶部、底部、左侧或右侧部分。 根据鼠标释放的位置不同，第一个窗
格相对于第二个窗格的位置改变。当拖动光标时，第二个窗格的一侧红色高亮，以指示第一个
窗格将要放置的位置。图 1-4 显示将该图标从顶部窗格拖动至底部窗格右部后的结果。
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图 1-4 将该图标从顶部窗格拖动至底部窗格右部后的结果。

注意： 将窗格从一个窗口拖动至另一个窗口。

拖动至另一图，以将活动数据添加至另一图的活动数据中

通过这个图标可将两个数据集逐点加在一起。 （来自最初单击过的窗格的）源数据添加至目标
数据（图标在这个窗格中释放）中。 修改数据的标题更新，以表明已修改。

注意： 只有类型相同的两个数据集，才可添加在一起。例如，质谱图不能添加至色谱图中。

注意： 如果目标图含有一个以上的叠加轨迹，那么默认源数据只添加至活动目标数据中。
如果按下 Ctrl 键，则源数据将添加至目标数据内的所有数据集中。

拖动另一个图，将活动数据从目标的活动数据中减除

通过这个图标从目标数据中减除源数据。 该图标对于背景减除质谱最为有用。

注意： 如果目标图含有一个以上的叠加轨迹，那么默认源数据只从活动目标数据中减除。
如果按下 Ctrl 键，则会减除目标中所有数据集的源数据。

提示！ 通常，不保留源数据内的强度大于目标数据内强度的数据点。 也就是说，不保留 Y
轴上的负值。 如果按下 Shift 键，则保留负强度点。

拖至另一图，以叠加目标图内的活动数据

通过这个图标叠加目标图上的源图内的活动数据。 操作完成后，目标图包含一个新系列和一份
目标数据。

注意： 如果源图含有多个叠加轨迹，那么默认情况下，只有一份活动数据会移动至目标图
中。 如果按下 Ctrl 键，那么源图内的所有数据集都会被叠加到目标图中。
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图

图就是能实现数据可视化和交互作用的窗格。 有些操作通用于所有图，但是其他的却取决于所
示数据的类型。

图 1-5 图

通用命令总结如下：

• 在图的 X 或 Y 轴区域内拖动光标可进行缩放和滚动。 双击可将轴重设至原始范围内，在
轴内单击，而按下 Shift 键可将图恢复至其原视图（缩放和滚动时撤销）。

• 通过拖动可定位阀值指示器。 阀值一般可确定哪个峰有标记，有时也用于确定哪些峰已经
过处理。

• 在数据区域内拖动可进行选择。 所做选择用于规定将要使用或处理的数据部分。 拖动时按
下 Shift 键可选择多个区域。 按下 Ctrl 键，确保在 X 和 Y 轴都做出选择。

图专用工具栏
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表 1-3 图专用工具栏图标

名称（工具提示）图标

将缩放图恢复至主页视图

将选择放大至全视图

显示‘缩放’图（以便跟踪当前缩放）。 请参阅图 1-6。

为选定的峰添加箭头标记

使用百分比刻度 Y 轴

标记所有叠加轨迹

填充峰

将图的 X 轴与窗口内的其他轴（具有相同的测量单位）连接（按住 Ctrl 键可应
用至当前所有图）

切换数据以使用上一个实验

切换数据以使用下一个实验

切换数据以使用选定的实验

显示可供选择的质谱

设置背景减除范围

注意： 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工
具栏。

从缩放图恢复至主页视图

如果详图已缩放，则应通过这个图标恢复至主页视图，也就是说，x 轴和 y 轴都显示其默认范
围且所有可用数据都可见的视图。 在 x 轴内双击可将图恢复至主页视图。 在 y 轴内双击只
能将该轴恢复至其全范围。

将选择放大至全视图

通过这个图标可缩放线图，这样选定区域将充满整个可用空间。 选定这个图标前，在线图内拖
动并做选择。 用户也可以在线图的 x 轴（或 y 轴）内直接拖动来缩放。

显示‘缩放’图（以便跟踪当前缩放）

通过这个图标可在主图下方显示一个小的复制图，如图 1-6 所示。 这个概览图始终显示全部
可用范围并能通过粉色选定部分指出主图的缩放区域。 随着主图的缩放，该选定区域会相应更
新。
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当将峰选定部分拖动至一个新位置时，主图可按需要滚动。 拖动选定部分的左或右边缘附近，
以调整其宽度。此时，主图可按需要缩放。

对于高分辨率质谱而言，这一功能很有用，这是因为经常需要很大程度地缩放以查看要求的详
情。 概览图允许用户一直跟踪相对于整个质量范围而言的缩放后区域所在位置。

图 1-6 显示概览图

为选定的峰添加箭头标记

通过这个图标可为图中当前选定的区域内的最大峰添加箭头标记。 图 1-7 显示当选定如图所
示的（大约） 829 个峰时单击这个图标后的结果。

图 1-7 添加单个箭头标记

箭头作为数据内的参考点使用。 默认情况下，不临近箭头的峰用其与最近箭头的距离标记。
邻近箭头且 X 值最大的峰则用其实际 X 值标记。 临近箭头但不同于最后一个的峰应相对于箭
头以较高的 X 值标记。 在图 1-7 中，约 829 Da 点对应的峰用其实际 m/z 值标记，而同位
素峰则用其相对于这个峰的距离进行标记。 箭头左侧的峰（未显示出）的标记值可能为负。

箭头最常用于质谱，便于查找预期质量差异，如：同位素、MS/MS 质谱中的中性丢失等等。 图
1-8 显示的是一个肽的 MS/MS 谱图，其中箭头添加位置对应氨基酸残基的中性丢失。 例如，
标记为 99.02 的峰可能是 1050.73 Da 峰的缬氨酸丢失，而下一个标记为 114.03 的峰可能是
天门冬氨酸的附加损失，等等。 标记为 -113.08 的峰可能是相对于标记为 129.02 的峰的亮
氨酸或异亮氨酸丢失（实际 m/z 比接近 709 Da）。
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图 1-8 添加多个箭头标记

如果未使用这种相对峰标记，那么可以清除 中显示的 Use Arrows for Relative Peak Labeling
菜单项图 1-9。此时，箭头用于标记特别感兴趣的峰。

图 1-9 添加箭头标记菜单

用户可以将箭头拖动至一个新位置。如果将箭头拖动至线图区域内，那么这会取消拖动操作。
如果用户将箭头拖至图外，那么箭头会被删除。也可选择 中所示菜单内的 Remove All Arrows
来删除箭头图 1-9。

使用百分比刻度 Y 轴

这个图标可确定 Y 轴的刻度。 选定后，可对叠加轨迹进行测量，这样各轨迹的最大值都为
100%。 如果叠加轨迹的绝对量值非常不同，那么使用百分比刻度 Y 轴就便利很多。

标记所有叠加轨迹

默认情况下，当多个轨迹叠加在一起时，只有活动轨迹才会被标记。 单击这个图标可标记所有
轨迹。 再次单击图标，可删除所有标记，然后恢复至原视图。

填充峰

单击这个图标，用深浅填充物交替填充峰，以获取活动数据。 该功能有助于查看峰的准确起点
和终点。再次单击这个图标，取消填充并恢复至原视图。

将图的 X 轴与窗口内的其他轴（具有相同的测量单位）连接

两个或多个图的轴可连在一起，这样当一个图中的一个轴被缩放时，其他轴会自动调整，以显
示相同范围。 该功能有助于比较这些图中的数据。另一种方法就是叠加相同图内的数据集。
但是，这种做法不总是我们想要的。

单击要连接的每个图中的“将图的 X 轴与窗口内的其他图（具有相同的测量单位）连接”图
标。如果在单击图标的时候按下 Ctrl 键，那么与活动图在同一窗口内具有相同 X 轴测量单位
的当前图形都会被连接。例如，如果三个质谱可见，单击 Ctrl + 其中任意一个的“将图的 X
轴与窗口内的其他图（具有相同的测量单位）连接”图标，那么这三个质谱之间将互相连接。
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注意： 在这个示例中，如果接下来生成一个新质谱，那么它不会与其余图相连接。 如要与
新质谱连接，可单击相关“将图的 X 轴与窗口内的其他图（具有相同的测量单位）连接”图
标。

默认情况下，只连接图中的 X 轴。 这种情况下，当手动缩放一个图时，其余图会自动缩放 Y
轴，这样视图内的峰将填满可用空间。

如要与已连接的图断开，可单击适当图内的“将图的 X 轴与窗口内的其他图（具有相同的测量
单位）连接”图标。 单击时按下 Ctrl 键可断开同一窗口内具有相同 X 轴的所有图。

切换数据以使用下一个实验

如果图中的活动数据与特定实验而不是前一个实验相关，那么通过这个图标可用相同类型的数
据替换这些数据，而不是下一个实验的数据。

例如，如果实验 2 的 TIC 处于活动状态，那么单击这个图标可切换至实验 3 的 TIC。 如果
实验 2 内给定时间的质谱处于活动状态，那么单击这个图标可切换至相同时间时的实验 3 的
质谱。

切换数据以使用前一个实验

如果图中的活动数据与特定实验而不是第一个实验相关，那么通过这个图标可用相同类型的数
据替换这些数据，而不是前一个实验的数据。

例如，如果实验 3 的 TIC 处于活动状态，那么单击这个图标可切换至实验 2 的 TIC。 如果
实验 3 内给定时间的质谱处于活动状态，那么单击这个图标可切换至相同时间时的实验 2 的
质谱。

切换数据以使用选定的实验

使用该图标可选择一个特定实验，不需通过逐个滚动的方式寻找所需实验。单击该图标，可打
开一个列出所有可用实验的对话框。活动样本高亮。 单击并选择列表中的一个实验，然后单击
OK。 请参阅图 1-10。
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图 1-10 Select Experiment 对话框

显示可供选择的质谱

通过这个图标可生成图中当前选择的时间范围内的平均质谱。 双击这一选择可获得相同的结
果。

设置背景减除范围

通过这个图标对从色谱图中生成的质谱实施自动背景减除。

质谱专用工具栏

表 1-4 质谱专用工具栏图标

名称（工具提示）图标

显示供选择的 XIC

注意： 关于该工具栏中的最后十一个图标的描述（从“将缩放图恢复至主页视图”图标）开
始，见图专用工具栏。

注意： 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工
具栏。
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显示供选择的 XIC

通过这个图标可生成图中当前选择的质量范围内得出的提取离子色谱图 (XIC)。

叠加

图中可能含有共享相同轴的不同轨迹，即所谓的叠加，这样便于对其进行对比。 拖动恰当的双
窗格图标（“拖动至另一图以叠加目标图内的活动数据”图标）可生成叠加，也可通过一些窗
格创建命令可自动生成。 请参阅色谱图和质谱。

在图 1-11 中，图中含有四个选定“标记所有叠加轨迹”图标的质谱。 图中的标题区显示两个
图谱的标题和指示轨迹颜色的带色圆圈。 活动轨迹以粗体显示。 这个轨迹是任何处理操作的
目标，如：阀值数据、平滑数据等等，通常是唯一带有标记的。 单击标题左侧的图标可更改图
标，而且只显示活动轨迹的标题。 当叠加很多时，该功能很有用。再次单击图标便可反向操
作。 如果有很多轨迹且光标在这些标题上移动，那么光标会变为双箭头，而且拖动时可作为滚
动条使用，这样可访问所有标题。

图 1-11 含有四个已选定“标记所有叠加轨迹”图标的质谱图

有多种方式可切换活动轨迹：

• 单击标题旁边的彩色圆圈

• 单击标题本身

• 单击轨迹内的数据点（不是轨迹本身）

在有叠加的图内单击右键后可显示快捷菜单，菜单内含有可用于可视化编辑所示轨迹的命令。
可按照预期使用 Remove Active Trace 和 Remove All Traces Except Active 选项。
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打开文件

如图 1-12 中所示，软件可打开不同类型的数据文件，拥有打开单个或多个样本的命令。

图 1-12 文件菜单

打开单个样本文件

通过 Open Sample 选项打开 Select Sample 对话框。 请参阅图 1-13。

通过这个对话框可选择单个文件。 生成的视图取决于所选指令，其中 single .scan 文件可显
示质谱或总离子色谱图 (TIC)，而多个 scan .wiff 文件可显示 TIC（如果为一个以上，则为
所有实验的总和）。

图 1-13 Select Sample 对话框
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单击 .wiff 文件左边的图标以显示文件内的所有样本，然后选择要求的文件名称。 如果文件
内只有一个样本，则选择文件名称并单击 OK。

打开多个样本文件

通过 Open Multiple Samples 和 Open Heat Map TICs from Wiff 选项可打开 Select Samples
对话框。 请参阅图 1-14。

左侧面板相当于允许浏览文件夹和指定文件的 Open 对话框，而右侧面板指示单击 OK 后将打
开的文件。 样本可按如下操作从左向右转移：

• 扩展 .wiff 格式的文件，选择样本，然后单击右指箭头。

• 扩展 wiff 格式的文件，选择样本，然后将其拖放至右侧面板中。

• 扩展 wiff 格式的文件，然后双击样本。

如果文件中含有多个样本，则通过选择 .wiff 格式的文件并单击右指箭头或选择 .wiff 格式
的文件并拖放至右侧面板而将其全部转移。

样本可按如下操作从右向左转移：

• 扩展 wiff 格式的文件，选择样本，然后单击左指箭头。

• 扩展 wiff 格式的文件，选择样本，然后将其拖放至左侧面板中。

• 双击样本。

图 1-14 Select Samples 对话框
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色谱图和质谱

搜索和查看数据时，总离子色谱图 (TIC)、质谱和提取离子色谱图 (XIC) 是最常使用的数据视
图。软件可提供这些数据视图之间的链接，以便用户快速生成质谱和 XIC，进而确定质谱内的
峰是否来自一个或多个色谱峰。

总离子色谱图 (TIC)

当打开一个扫描或多个扫描 wiff 文件时，默认显示这个视图。 所示 TIC 对应通过以下方式
生成的色谱图：累积各质谱内的所有离子，然后根据保留时间绘制强度累积线图。

如果通过循环实验采集到样本，那么显示的 TIC 对应两个实验的强度累积，而且 x 轴内会画
出一个特殊箭头指标以对此做出指示。 请参阅 图 1-15。 如果双击该指标，则会出现一个显
示各实验的叠加 TIC 的新窗格。

图 1-15 TIC

如果样本中含有 IDA 数据，则可选择任一个 IDA Explorer，这是一种显示选定前体的质量和
保留时间或传统 TIC 的图形方法。 如果选定传统 TIC 选项，则会显示用于 IDA 测量和 IDA
相关总和的单独 TIC。

单击 Show > Total Ion Chromatogram (TIC) 并打开允许选择实验的对话框后，可随时显示
TIC。 选择时段 1 可显示所有实验的 TIC，而其他条目对应各个 TIC。 使用 Shift+ 或 Ctrl+
单击，以选择多个选项。

质谱

如果一个文件中只含有单个质谱，那么当打开该文件时会显示该质谱。

对于包含多次扫描的数据，在色谱图中选择并在色谱图内双击或单击“显示可供选择的质谱”
图标，便可从色谱图中得出质谱。拖动色谱图内的选择矩形，更新质谱，进而显示新区域。

完成第一次选择后，通过按下 Shift 键可选择多个区域。 双击这些选择中的任意一个或单击
“显示可供选择的质谱”图标可生成一个新的质谱窗格，之前的质谱被覆盖。
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对于 IDA 而言，迅速叠加所有独立质谱或仅显示第一个打开的质谱。 在后一种情况下，使用
左右箭头键可显示另一个质谱。

注意： 对话框中只有一个 Only show again if the shift key is down 复选框。

通过两种方式可生成经过背景减除的质谱：

• 分别生成峰质谱和背景区域质谱，然后将减除双窗格图标从背景质谱拖动至峰质谱。

• 通过在色谱图中做出一个或两个选择并点击“设置背景减除范围”图标来定义背景区域。
当背景区域定义好后，生成的任何质谱都会自动进行背景减除。 背景区域在色谱图内显示
为淡红色选择矩形，它和任何质谱选择都可移动以改变显示的数据。 当背景区域定义好后，
单击图标旁边的箭头，然后选择“清除减除范围”便可将其删除。

注意： 箭头标记在质谱中很有用，这是因为峰标记可能与用箭头标记的最近的峰相关，这样
可快速确定丢失物或加合物的质量。 如果有多个叠加且选定了“标记所有叠加轨迹”图标，
那么各叠加则会相对于箭头做出标记。

提取离子色谱图 (XIC)

XIC 可通过下列两种方式生成：

• 单击 Show > Extracted Ion Chromatogram (XIC)。

这个操作可打开一个对话框，在其中可以根据模式开始或停止质量，也可以键入中心或宽度
值。 在对话框内单击右键可打开快捷菜单，通过快捷菜单可进行修改。 通过快捷菜单还可
以使用其他有用命令，如：设置默认宽度和导入或导出质量列表。 用户还可以永久保存质
量值，除非被删除，否则这样它们可一直自动使用。

• 在质谱内做出一个或多个选择，然后双击其中之一或单击“显示可供选择的 XIC”图标。

这些操作可生成与每个选择对应的 XIC。 默认情况下，程序可确定每个选择范围内的最大
峰并自动设置与半高低和高质量值对应的峰的 XIC。 如果按下 Ctrl 键，则使用整个选择
宽度。

两种情况下，所显示的图都是每个选定部分都只有一个叠加的图。 这些选定部分会转为连接。
拖动连接可更新 XIC。

注意： 通常，XIC 是在整个色谱图范围内计算和显示的，这个过程可能较慢，尤其是在有多
个选定部分且数据来自高分辨率仪器并含有很多扫描的情况下。 一个有用的功能就是将 XIC
范围限制在用于生成范围的质谱保留时间附近的一个较小窗口内。 单击 Edit > Options >
XIC 选项卡后出现一个对话框，可在其中的 XIC 选项卡中进行过此类设置。

等值线图与热图

LC/MS 等值线图（Show > LC/MS Contour Pane）可在单个窗格内显示 LC/MS 样本的所有数据。
图 1-16 中的示例显示的是一个 TIC 和相应的等值线图，图中所示为 m/z 比率对保留时间的
数据图，其中颜色编码代表强度。 这个案例中还显示了颜色控制，但是在视图中单击右键并清
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除 Show Appearance Controls 选项可隐藏颜色控制。 由于等值线图和色谱图拥有同一个 X
轴，所以它们可以连在一起，这样缩放和滚动会对两个视图产生类似的影响，便于进行对比。

图 1-16 TIC 和相应的等值线图

颜色控制使用 256 色调色板显示按 min% 和 max% 规定的范围内的强度。 Min% 以下的强度用
< min 绘图，而 max% 以上的强度用 > max 绘图。 如果使用代表 < min 的颜色且数据都不同
（如图所示），那么低于 min% 的数据都会消失。 这是一种可简化图 1-17 中所示线图的视觉
阀值形式，图中已将 min % 值提高至 0.5%。 关于颜色控制的更多信息，请参阅系统用户指
南。
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图 1-17 等值线图，最低百分比值提高至 0.5%

通过降低 max % 可强调低强度峰，这样调色板可涵盖一个较小强度范围，但是大于该值的所有
峰都以相同颜色表示。 通过选定 Log Scale 复选框也可对此进行强调。 激活 Log Scale 要
求 min % 的值不能为零（如：1 或 0.1），然后将颜色映射到百分比强度对数。

软件中的多样本可视化工具可显示 TIC、XIC 和作为一系列单一热图的多样本质谱，这有助于
样本对比。 图 1-18 是六个分析物的一系列 TOF 色谱图。 请参阅对多个样本有效。
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图 1-18 热图色谱
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本节描述的是一些最常用的处理选项。 所用文件为含有大量环回实验的 IDA 文件，但是在本
示例中，使用的是第一测量实验，用于模拟一个简单的 LC/MS 分析。 下一节将探讨 IDA 功
能。

打开数据文件

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

图 2-1 Select Sample 对话框

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。 关于已
安装的数据文件位置的信息，请参阅 机构。

3. 要显示文件内的所有样本，可单击 Bromocrip_IDA-DBS alone_T=1.wiff 文件左侧的图标。

Bromocrip_IDA-DBS alone_T=1.wiff 文件中只有一个样本。

4. 选择样本名称，然后单击 OK。

因为这是一个 IDA 文件，所以软件提示您具体说明如何打开选定的样本。
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图 2-2 打开 IDA 样本

5. 如果尚未选择，则单击 As a standard TIC，然后单击 OK 生成图 2-3 中所示的 TIC。

图 2-3 TIC

这个窗格中叠加有一个全谱扫描 TIC（蓝色）和一个叠加独立（产物离子）扫描。 在这种
情况下，我们希望处理测量数据，以单独显示测量 TIC。
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显示一个实验的 TIC

1. 双击 X 轴中心的“双击以叠加所有实验的 TIC”图标，以生成全部实验的叠加 TIC。

新色谱图就是活动窗格。 另外，由于测量是第一项实验，新色谱图就是标题区中加粗标题
的活动轨迹。

图 2-4 叠加 TIC

2. 在活动色谱图窗格中右击，然后单击 Remove All Traces Except Active，以便只保留测量
TIC。

图 2-5 右键菜单

3. 在同一窗格内，单击“删除其他所有窗格”图标，以只留下测量 TIC。
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图 2-6 测量 TIC

显示已知分子式的 XIC

虽然在 4 - 7 分钟范围内明显存在一些小峰，但由于背景信号在该数据中相当强，因此许多峰
可能会被其掩盖。由于这个样本符合溴隐亭的微粒体温育，可使用预期分子离子的 m/z 比作为
到达峰位置的初步指引。 溴隐亭的分子式为 C32H40N5O5Br， 由于这是负极性模式数据，我们
希望看到一个 (M – H)– 离子。

1. 单击 Show > Mass Calculators。

2. 单击 Mass Calculators 窗格中的 Mass Property 选项卡。

3. 在 Formula 字段中键入分子式。

4. 在 Charge state 字段中键入 -1。

5. 选择 ‘H+’ charge agent (else electron)。

6. 单击 Calculate。

注意： 也可以从分子式中手动删除一个氢，而不选定 ‘H+’ charge agent (else
electron) 复选框。

刷新对话框显示一系列质量值：单同位素、平均值等等。
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图 2-7 质量计算器窗格

注意： 在这些质量值下，同位素容易分辨。因此，单同位素的 m/z 值是最恰当的值。

7. 选择 Monoisotopic m/z 值，然后按下 Ctrl+C 键将值复制到剪贴板。

8. 单击“删除窗格”图标以删除 Mass Calculators 窗格，或单击“隐藏窗格”图标以隐藏窗
格。

9. 单击 Show > Extracted Ion Chromatogram (XIC) 以打开 Specify XIC Ranges 对话框。
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图 2-8 Specify XIC Ranges 对话框

10. 在 Specify XIC Ranges 对话框中单击右键打开快捷菜单。

11. 在快捷菜单中，执行以下操作：

a. 确保未选定 Start/Stop Mode 选项，这样 XIC 值可作为中心值和宽度输入。

b. 单击 Set Default Width，键入 0.05，然后单击 OK。

c. 单击 Persist Ranges for Future Use，以便下次使用对话框时这些值还保存在内。
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图 2-9 快捷菜单

12. 返回至 Specify XIC Ranges 对话框。

对话框现已设置为每个相关 XIC 只能输入一个质量值并使用一个默认宽度。

13. 选择 Center 下方的第一个单元格，然后按下 Ctrl+V 键并粘贴从步骤 7 获得的质量值。

14. 单击 OK。

注意： 由于已设置默认宽度，所以不需要另外输入宽度值。

现在的窗格中含有溴隐亭的预期分子离子的 TIC 和 XIC，显示有多个峰。

图 2-10 溴隐亭的预期分子离子的 TIC 和 XIC
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生成并与质谱交互

1. 隐藏 TIC 窗格，在 XIC 内的最大峰附近做出选择，然后单击“显示可供选择的质谱”图标
以生成该区域的平均质谱。

图 2-11 XIC 内最大峰的质谱

注意： 在图 2-11 中，Options 对话框的 Peak Labeling & Finding 选项卡上的 Label
字段（通过 Edit > Options 获取）被设置为 Mass (Charge)。

2. 从约 630 -- 700 Da 处拖动 X 轴，将质谱缩放到这个区域。

注意： 这可能需要通过两个步骤来完成。

在非常接近预期值 652.2140 的 652.2199 点处有一个也显示溴同位素形式的峰，但是从
668.2158 开始有一个第二溴同位素群集。精确 m/z 比值因 XIC 内选定的准确保留时间窗
口不同而不同。

注意： 此处使用的标记类型在括号内显示 m/z 比和电荷状态预估（基于峰间距）。 单同
位素峰也用一个星号标记。 标记算法并没有考虑到除 13C 以外的同位素，因此该算法将
81Br 同位素标记为单电荷同位素，但是却错误地将其标记为单同位素。

3. 单击 Edit > Options，前往 Peak Labeling & Finding 选项卡，然后将设置改为 Label
字段中的 Mass / Charge，这样可将标记类型改为默认类型。

4. 单击 OK。
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图 2-12 不同标记类型的质谱

5. 在扩展的质谱中，在 652.2199 所对应峰周围选择，然后单击“为选定的峰添加箭头标记”
图标。

图 2-13 质谱，在选定峰上显示

质量标记现在与选定的峰相关，这样可显示质量峰之间的差异。 现在，668.2158 处峰标记
的读数为 15.9959（相当于氧的质量），表明这个峰为烃基溴隐亭的代谢产物。

提示！ 将箭头拖动至另一峰便可移动箭头，而从与箭头图标相邻的列表中选择 Remove
All Arrows 可删除箭头。

6. 在 15.9959 所对应峰周围选择，然后单击“显示供选择的 XIC”图标。

7. 在 XIC Selection Ranges 对话框中，单击 OK。
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图 2-14 XIC 选择范围对话框

图 2-15 XIC

这是一种交互式地生成 XIC 的有用方法。 默认情况下，XIC 所用宽度是半高处的质量峰的
宽度，选择连接显示于质谱内。

8. 拖动选择连接以更新显示的 XIC，重复这一步骤添加更多。

9. 在这个新色谱图内单击 “拖动至另一图以叠加目标图内的活动数据”图标，然后将色谱图
拖动至原 XIC 窗格，这样它们可叠加在一起。
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图 2-16 叠加的 XIC

10. 隐藏或删除第二个色谱图窗格和质谱，然后缩放叠加的色谱图以显示 4 - 5 分钟左右的区
域。

4.4 分钟附近有两个分别来自 XIC 的峰，它们以非常接近但不是完全相同的保留时间进行
洗脱。在 668.216 色谱图中也有大量峰，可大概说明其中含有其他烃基代谢产物。

11. 双击色谱图窗格内的 4.4 分钟处，以生成单个扫描的质谱。
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图 2-17 单个扫描的质谱

XIC 中的虚线指所示扫描（用图 2-17 中的箭头标记）。 如果拖动这条线，则质谱更新，
进而可查看 4.40 分钟附近的区域。使用向前和向后箭头一次移动一个扫描。 通过将线条
移动至 668.215 离子的信号为零的区域内（但即使在这里背景也非常高）可能获得 m/z 比
为 652.214 的峰的干净质谱，但是后者的干净质谱无法通过这种方式获得。

12. 删除质谱窗格。

13. 在色谱图窗格内，缩小选择范围（包含 652 峰的左侧，但是不包括 668 峰），然后单击
“设置背景减除范围”图标。

选定部分变为粉红色。

设定好减除范围后，接下来生成的质谱将自动进行背景减除。 单击“设置减除范围”图标
右侧的小箭头访问列表，然后在列表中选择“清除减除范围”便可清除该范围。

14. 在色谱图中选定另一部分，其中应包含 668 峰的最高点，但是应尽可能少地包含 652 峰，
然后单击“显示可供选择的质谱”图标。
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图 2-18 668 峰的背景减除质谱

得到的结果是 668 峰的背景减除质谱且几乎不含 652 峰。 即使背景不可见，色谱图内的
两个选定部分仍然与各自的质谱连接在一起，而且可移动至色谱图内的其他部分。 移动质
谱选定部分将自动更新显示出的质谱，但是如果背景区域发生变化，那么这个操作就只适用
于接下来生成的质谱。

15. 单击“隐藏所有其他窗格”图标，在单个质谱 TIC 内单击，然后单击“删除所有其他窗格”
图标，以便只显示 TIC。

16. 如果 TIC 窗格已删除，则单击 Show > Total Ion Chromatogram (TIC)，选择 Period 1,
Experiment 1，然后单击 OK。

使用等值线图

查看数据集（色谱图或谱图）各部分的另一种方法就是使用等值线图来获取某一实验的完整概
况。 等值线图可提供很多信息，但是通常必须通过调整查看参数来获取最佳结果。 在这个例
子中，前体化合物经过溴化处理，而等值线图可提供一种通过溴同位素形式来定位峰的方法。

1. 只有单个实验 TIC 处于活动状态时，单击 Show > LC/MS Contour Pane，然后在生成的等
值线图中的工具栏中单击“展开活动窗格填充窗口”图标，这样就只有这个窗格可看到。

2. 如果外观控制（左下角的颜色复选框）不可见，则在窗格内单击右键，然后单击 Show
Appearance Control。 请参阅等值线图与热图和参考指南。
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图 2-19 等值线图

提示！ 对于默认参数而言，这个视图不是很有用，这是因为这个视图中低水平峰和会掩盖
真实峰的噪声占主导。 通过以下方式生成一个更好视图：

• 更改要显示的最低强度。 这会改变低于这个水平且应以与无数据的点颜色相同的颜色
绘制的所有数据点，也就是说，它们变得不可见。

• 改变颜色映射，这样可用颜色会覆盖用于强化小峰可见性的较窄的强度范围。

3. 将 min %值改为 0.01。 这会导致强度低于 0.01% 基峰的所有数据点消失。
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图 2-20 等值线图

数据中显示了更多结构信息。 空隙容积和列清除区很清晰，有很多在所有保留时间都出现
且显示为水平线的背景峰。

4. 选中 Log scale 复选框。

选定的颜色被映射到强度对数（以基峰强度百分比表示），有强化较低强度峰的作用，例
如：4 - 4.5 分钟左右的峰群（质量范围 600 - 700）。

5. 选择这个区域，然后单击“将选择放大至全视图”图标。

提示！ 也可以按照常规方式分别缩放 X 轴和 Y 轴。
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图 2-21 等值线图

现在的视图显示，在这个区域内有很多溴化峰，通过四条对应于 79Br 和 81Br 同位素及其
13C 同位素的平行线可对其进行区分。

6. 在颜色控制设置下进行实验，观察对视图的影响。

7. 完成后，关闭窗口。

这样也会关闭数据文件。

摘要

本节中对下列任务进行了讨论：

• 浏览并打开一个数据文件，以显示 TIC。

• 更改视图，以便只用一个实验。

• 通过质量计算器来确定元素组成中的离子质量，并使用该质量生成 XIC。

• 交互生成质谱和色谱图，使用质谱上的箭头标记来显示峰之间的质量差异。

• 生成背景减除质谱。

• 使用等值线图生成一个数据集概览。

不论所显示的数据类型是什么，这些操作都是所有交互数据处理的基础。
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在 IDA 实验中，当一个或多个测量质谱中的数据符合特定标准时，可自动收集 MS/MS 质谱（和
可能的 MS3）数据。 通常会设置参数，在特定时间段内排除前体离子质量（不允许其作为触发
器），以避免从同一 LC 峰收集多个质谱。 偶尔，也可能会收集到冗余质谱。 另外，由于一
旦峰满足标准就会触发 IDA，所以一般会早在 LC 峰时就生成质谱，但是质量可能不是最佳。

软件中含有显示、过滤和处理 IDA 数据的工具。 本节中对部分工具进行了探索。

开始前请关闭所有已打开的窗口。

显示并合并质谱图

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 Bromocrip_IDA-DBS alone_T=1.wiff 文件，然后单击 OK。

4. 在 Open IDA Sample 对话框中，单击 With the IDA Explorer，然后单击 OK。

程序会检查数据文件中的所有质谱，然后生成下列图。
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图 3-1 IDA 查看器

左边窗格中含有一个 Graph 选项卡和一个 Table 选项卡。 Graph 选项卡可显示一个虚拟
等值线图，其中每个数据点代表保留时间和被选定为前体离子的 m/z 比。 Table 选项卡显
示虚拟等值线图上数据点的表格视图。 右侧面板显示选定数据点的质谱。 最初显示的是第
一个 MS/MS 质谱。

等值线图使用颜色强度来反映峰强度。 颜色越深，则峰强度越大。 在可以设置标记的地方
设置标记，以确保它们不会与数据点重叠或相互间重叠。 放大等值线图，以便更详细地检
查该区域和显示更多标记。

5. 在左面板中，缩放 4 - 5 分钟以及 640 - 700 Da 的区域，此处的峰与此前发现的溴隐亭
相关。

左侧图（图 3-2）只显示左侧面板。 如果当前的视图不同，则单击 Show Options 图标并
清除 Options 对话框的 General 选项卡上的 Merge spectra with similar precursor
masses 复选框。

该区域中收集了大量 MS/MS 质谱，尽管色谱峰非常窄，但是有些可能来自相同峰。 此外，
还针对同位素群集中的每个峰收集了 MS/MS 质谱。

6. 继续放大图，将峰群集集中在 m/z 比为 668 Da 到 672 Da 之间的区域。 请参阅图 3-2
中的右侧面板。
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图 3-2 IDA 查看器

7. 选择 669.2197 峰中的第一个峰（在上文右侧面板中显示为一个星号），然后单击“显示供
选择的 XIC”图标以显示全谱扫描中该前体离子质量的 XIC。

一开始就选择峰，这样就会显示出相应的 MS/MS 质谱。
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图 3-3 全谱扫描中前体离子质量的 XIC

如果等值线图中有一个未标记的数据点，则应将光标移至该点以显示 m/z 比和保留时间标
记，这样就可以关联产物离子扫描的次数和全谱色谱图。

对于 669.2 峰，前三次扫描与 4.21 分钟（这也是 668.2 扫描生成的地方）的第一个 XIC
峰相关，紧接着的两次扫描与 4.27 分钟的峰相关，而最后一次扫描来自 4.42 分钟的峰
(669.2177/4.46) 。在 4.52 分钟时的 669.2 峰未进行任何扫描，但是从 670.2 峰获得了
一个扫描。

注意： 扫描次数稍有不同，这是因为即使是在相同全谱扫描中检测到的，它们也是按顺序
获得的。 较小的同位素峰可能会晚于较大的峰而被检测到。

8. 在前五个 669.2 扫描附近画一个选择矩形，右击，然后选择 Select Points in Graph
Selection。

这样，质谱窗格会叠加在所有 MS/MS 质谱上。

系统已获得比需要更多的扫描。 减少要处理的质谱数量并合并那些太接近而不会是不同化
合物的质谱，这样我们就可以获得更高质量的结果。 合并操作使用质量和保留时间，以确
定这些扫描。
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9. 单击 Show Options 图标，选择 Merge spectra with similar precursor masses 复选框，
然后将 Mass tolerance 设置为 10 ppm，将 RT gap tolerance 设置为 0.03 分钟 （该分
析中的峰约为 2 秒 宽）。

10. 单击 OK。

注意： 对话框的这个部分还允许用户设定如何提取 XIC。 质量宽度应与仪器的分辨率或
峰宽相匹配，由于可加速处理，所以这有助于限制所用的时间范围。

以这种方式合并数据后得到三个 669.2 峰（4.21 分钟、4.28 分钟和 4.46 分钟）。IDA
查看器窗格底部的状态栏显示数据合并进程，然后显示合并完成后相关质谱的总数。

11. 单击 670.2149/4.26 对应的数据点，然后按下 Ctrl 键并单击 668.2162/4.27 对应的数据
点。

12. 在 MS/MS 质谱窗格中，单击“展开活动窗格填充窗口”图标，“使用百分比刻度 Y 轴”图
标和“标记所有叠加轨迹”图标，然后缩放 x 轴以显示 340 到 680 之间的区域。

图 3-4 质谱：m/z 340 到 680 之间的缩放区域

由于这两个前体对应 Br 同位素，所以除保留 Br 原子的离子外质谱应完全相同，显示为按
每两个 Da 分开的一对峰。 本示例中，344.0441、625.1765 和 637.1712 处的碎片（668.2
轨迹）保留了 Br 原子，而 340.1925、367.1796 和 588.2877 处的碎片没有保留。

在 588.2877 峰处放一个箭头，然后观察现在标记有 Br 同位素质量加 1 的 668 和 670
峰，表明 588.2877 峰对应于丢失的 Hbr。

13. 删除质谱中的箭头，单击“展开活动窗格填充窗口”图标，然后缩小等值线图以查看所有数
据点。
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过滤 IDA 数据

IDA Explorer 含有很多过滤器，可用于缩减要可视化或要处理的数据量。 本节中对这些过滤
器进行了描述。

1. 在等值线图中，单击“展开活动窗格填充窗口”图标，然后单击工具栏下方的 Filtering
Controls 旁边的图标。

图 3-5 过滤 IDA 数据

该窗口有多个滑块和复选框，每一个对应一个可用于调节所示数据量的不同过滤标准。此处
可通过缩放视图来选择保留时间（Time））和 m/z 比 (m/z)。

其他过滤器如下所示：

• TIC：设置 MS/MS 谱图中的峰强度累积极限值。 通常用于删除小的噪声扫描。

• Quality：指大于 1 个同等物的强度累积分数，一般不太可能由噪声造成，是对光谱质
量的预估。

• Matched Int. (%)：使用 Fragment Matching 时，可对通过已知碎片和中性丢失进行解
释的强度累积分数作出评估。

• Similarity：当已设置参考谱图时可用。 该功能可用于测量与参考谱图中的普通碎片和
中性丢失相对应的强度累积分数。请参阅使用参考谱图。

• Mass Defect ：可设置某一质量小数部分的单个范围。 该功能对于寻找代谢产物非常有
用，因为常见代谢转化（O、O2 等等）不会明显改变前体分子的亏损，所以使用接近其
亏损的范围可能会找到可能的代谢产物。
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• Defect in Range：除单个质量亏损范围外，软件还允许用户定义多个适用于不同质量范
围的亏损值。 如果已规定这类范围，那么通过这个复选框用户可确定是否应用过滤器。
范围可在 Options 对话框的 Mass Defect 选项卡上设置。

• Isotope pattern：该复选框允许用户将一个或多个同位素形式过滤器应用于 MS 测量数
据。 也就是说，只有当选定的前体离子具有所需形式时，才会显示数据点。这些形式可
在 Options 对话框的 Isotope Pattern 选项卡中界定。

每个简单数据过滤器都有两个滑块，可用于界定范围。 双击任一滑块，然后直接键入一个
值。

2. 滑块设置好后进行实验，应尤其注意的是，即使是 TIC（如：1e3）或 Quality (1) 值的
最低设置也会有惊人的效果。 将较低 TIC 过滤器设置为 2e3，其他全部设置为 0。

溴隐亭的质量亏损约为 0.22，因此简单代谢产物不可能有大于该值的值或更低的值。

3. 将 Mass Defect 过滤器设定为 0.18 和 0.23，同时注意观察其余峰是否在 4.5 分钟和
650 Da 的邻近范围内，并且该区域（4.40 分钟）内只有一个源自 m/z 比等于 652.2211
时的数据点。

4. 点击 Filtering Controls 旁边的图标可隐藏过滤器控制。

提示！ 要更改可见的过滤器，可在过滤器区域内点击右键，选择 Filters，然后选择恰当
的过滤器。

使用参考谱图

1. 在等值线图内，点击 652.2211/4.40 处的数据点（溴隐亭本身），然后点击“设置参考谱
图（用于相似性打分）”图标。

注意： 可能需要先缩放图。

2. 单击“设置参考谱图（用于相似性打分）”图标旁边的箭头，然后确保选定 Overlay
Reference Spectrum。

3. 点击 654.2185/4.39 处的数据点。

参考谱图设定好且 Overlay Reference Spectrum 选定后，显示的任何质谱都有叠加的参考
谱图，这样便于对比。 处理代谢产物时这个操作很有用，这是因为该操作可以提供一个快
速确定哪个峰发生变化的方式。

我们已经绘制出作为参考的低质量溴同位素的前体离子的 MS/MS 谱图，而且已经叠加了较
高质量同位素的质谱，这样我们就拥有一个类似于先前生成的 668.2 峰的视图。也就是说，
含溴离子可通过相距两 Da 处出现的峰来识别。

4. 单击“展开活动窗格填充窗口”图标，然后在等值线图中单击 Table （位于 Filtering
Controls 正下方）。
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注意： 如需要，将质谱窗格移动至表下方（使用“拖动并重排窗格”图标），这样所有列
就都可见了。

表中显示与图形管理器相同的信息，但是提供更多详情。 它也对过滤控制作出回应，这样
两个视图就含有相同的质谱。 表与质谱视图连接后，选择行时质谱会更新，而单击列标题
可对行进行分类。

当设定好参考谱图后，多出以下两列：Delta m/z 显示与行相对应的参考物谱图和质谱的前
体离子质量差异。 Similarity 显示两个质谱的相似度。

5. 单击 Delta m/z 对表格进行分类，然后观察到它包含几个峰，相差约 15.995（氧质量），
而 31.990 (O2) 点处的峰可能是烃基溴隐亭的代谢产物。

6. 单击表中的某一行显示相关质谱。

注意： 这些质谱中有与扫描高度相似的值，其中前体质量高两个 Da，这些值来自于含有
离子的 81Br。

摘要

本节中对下列任务进行了讨论：

• 通过图表 IDA Explorer 视图检查 IDA 文件。

• 确定需要时，合并相关质谱。

• 使用 TIC 和质量亏损过滤器过滤显示出的质谱数。

• 叠加质谱，以便对其进行对比。

• 设定一个参考质谱，然后使用表格找到类似的代谢产物。

这些操作对于 IDA 数据处理很重要。

下一节的内容是通过使用溴隐亭的 MS/MS 质谱来描述如何使用结构工具。
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软件中含有帮助将离子质量连接至结构（保存为 .mol 格式的文件）并探索生物转化可能位置
的工具。

将结构与 MS/MS 质谱关联

1. 查找溴隐亭的 MS/MS 谱图位置，652.2211/4.40。请参阅使用 IDA Explorer。

2. 单击等值线图内“隐藏所有其他窗格”图标，以便只有质谱可见。

3. 单击 File > Open Mol File。

4. 在 Select Mol File 对话框中，选择 Bromocriptine.mol 文件，然后单击 Open。 关于已
安装的数据文件位置的信息，请参阅 机构。

新窗格在质谱下方打开并显示结构和工具。
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图 4-1 溴隐亭结构

5. 单击结构窗格内的 Show options 对话框，确保选择 Zoom spectrum (if any) on
selection）和 Mark selected fragment mass with arrows 复选框，然后单击 OK。 其他
参数可保持不变。
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图 4-2 结构选项对话框

质谱和结构会自动连接，这是因为创建结构窗格时质谱处于活动状态。 将“显示可供选择
的质谱”图标拖动至适当的质谱便可手动连接结构与质谱。

在结构窗格内拖动时会在光标后产生一条线（套索），以便用户选择将以粗体绘制的全部或
部分结构。因为有一个已连接的质谱，所以可缩放和滚动，以显示选定子结构质量的周围区
域。

6. 在整个分子周围画一条套索，视图发生改变，显示 m/z 比等于 652.2177 时的峰，这与 (M
– H)–离子相对应。

因为已选定 Mark selected fragment mass with arrows 复选框，所以在峰上下方画一个
红色箭头，以表明这是与相应选定区域相对应的预期离子质量（即：(M – H)-，因为这个
数据为负极性模式）。

注意： 结构窗格的标题指示元素组成和与选定部分对应的中性化合物的质量（也就是说，
C32H40N5O5Br，质量为 653.2213 Da）。

如果选定 Mark selected fragment mass with arrows，那么当结构窗格内未选定任何选项
时会在 652.2177 峰处绘出绿色箭头。 这是因为绿色箭头标记的是当前选定部分的补充，
如果没有选定部分，则补充为整个分子。

7. 选择除溴原子以外的整个分子。 请参阅图 4-3。
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图 4-3 溴隐亭结构

注意： 只有溴原子用的是普通字体，结构窗格内的标题显示组成和质量，分别为 C32H40N5O5
和 574.3029 Da。在质谱中，红色箭头指示所做选择的预期质量，也就是说，(M – H)–

分子离子的质量小于溴的质量，在距离各侧 1 Da 远处也有箭头。碎裂期间获得或丢失额
外氢原子是很常见的，软件在各个断键的 +1 和 –1 处画了一对蓝色箭头，表明存在这种
可能性。 在这个例子中只有一个键断裂，所以只有两个附加箭头。

质谱中的实际峰与这些箭头中的一个相对应，表明额外氢原子（也就是 HBr）丢失，因此离
子质量对应于 (M – H – HBr)–。

操作碎片

软件中含有可生成核素质量的碎片离子预测因子，这些核素是通过打破化学键并加入或去除氢
原子而形成的。

注意： 此项预测只是纯粹的运算，并没有应用化学逻辑，所以可能会对生成的碎片估计过
高，但是对于碎片分析而言这仍是一个有用的工具。
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1. 当结构窗格处于活动状态时，单击 Show > Fragments Pane。

根据 Fragment Options 对话框中的设置，可能会显示一个进度条。 请参阅图 4-4。

2. 单击 Show options 对话框图标，设置图 4-4 中显示的参数，然后单击 OK。

图 4-4 Fragment Options 对话框

设置选项，以便产生一小组简单碎片，然后根据需要增加断键的数量和类型，以对观察到的
离子做出解释。 允许很多键断裂会减缓程序并生成大量不太可能的碎片。

关于 Fragment Options 对话框中的大部分参数，见参考指南，但是还应注意以下内容：

• 如果已选定 Automatically recalculate on-the-fly 复选框，那么对质谱（切换至另
一个不同质谱，调节参数）或选择做出的任何更改都会导致对碎片进行重新计算。 通常
这是期望的行为，但是如果选项设置为生成很多碎片时可能会影响分析速度。 如果不使
用这个选项，则应单击“碎片”图标。

• Constrain using peak list 表示软件只显示与质谱内的峰匹配且允差恰当的碎片。
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• Require evidence for previous step when breaking bond 只在一个以上的键断裂时
有效。 程序首先断裂一个键，然后考虑断裂所生成的碎片中的键。 如果已选定这个选
项，则在这些键进一步断裂前必须有与其相对应的离子。

根据这些参数，视图应类似于 图 4-5，但是可能会稍微不同，这是因为只考虑了阀值设置
以上的峰（也标记了）。

图 4-5 溴隐亭结构

注意： 质谱内的峰做了标色，以指示与碎片选项卡内的峰相匹配的已指定（蓝色）和未指
定（红色）的峰。

碎片窗格含有两个选项卡：

• Fragments ：在这个例子中，列表较短，这是因为在这些条件下生成的碎片不多，只有
其中一部分按需要与质谱内的峰相匹配，因为选定的是 Constrain using peak list 复
选框。

• Peaks：显示一个峰列表，内容包括质谱内阀值以上的峰、其强度以及它们是否已指定给
碎片。对于已指定的峰，表中还显示质量错误。
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图 4-6 碎片窗格

3. 在 Fragments 选项卡中，选择 m/z 比为 324.1929 的一行。峰用红色箭头标记，以表明这
是预期质量，结构窗格内的相应子结构以粗体标出。

图 4-7 Fragmentation 对话框
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注意： 结构窗格标题内的组成和质量现在反映的是离子质量，而不是中子质量。

4. 检查指定给其他碎片的结构。

它们都与将分子的两个循环部分分开的酰胺键相关，而且看起来似乎是可能的。

注意： 已指定的元素组成与使用参考谱图中生成的叠加质谱一致，通过对比含有分子离子
的 79Br 和 81Br，推断碎片中含有 Br。

5. 缩放质谱，以使整个质量范围都可见。

其中两个主峰（m/z 为 324.1970 和 m/z 为 344.0430，对应于分子两侧）已指定，而且以
蓝色线绘出。但是，仍有许多峰未指定。

6. 打开 Options 对话框，然后将 Maximum number of bonds to break 改为 2。

注意： 根据阀值设置，该选项可能会导致一些小峰被指定，而不是丰度更高的峰（例如：
m/z 比为 114.0584、209.1337 或 227.1431）。如果质谱相对于红色箭头做出标记，则应
在结构窗格内单击并清除所做选择，以显示绝对质量值。

7. 选择 Break ring bonds 复选框，然后单击 OK。

现在很多额外离子都已匹配，包括 m/z 为 209.1337 和 227.1431 时的离子。在 Fragments
窗格内选择新质量并加亮子结构，表明它们与分子的循环肽部分的环破裂相关。在确定这个
区域内的代谢转化点时，这些离子可能会有用。

向质谱添加子结构

选择结构部分，然后用它们为质谱做注释，以供未来参考。根据质谱窗格的大小，使用结构窗
格内的 Options 对话框调整 Target Bond Length，以供复制。

1. 在 Fragment Options 对话框中，清除 Break ring bonds 复选框以简化碎片数量。

2. 在碎片窗格中，选择与更丰富离子之一对应的行，以强调相应子结构。

3. 单击结构窗格内部。

4. 单击 Edit > Copy。

5. 在活动质谱窗格中右击，然后单击 Paste Image。

这样可将子结构图像粘贴进质谱窗格内。

6. 拖动图像，将其移至目标位置。 单击右键并选择 Delete Image 可完全删除图像。

图像与质谱相连接，也就是说，质量强度位置，这样用户滚动和缩放时它们可移动。

7. 对于其他碎片离子，可重复步骤 2 至步骤 6 并生成与图 4-8 类似的最终图像。
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图 4-8 带有新增子结构的质谱

8. 单击 File > Print > Print Preview Window，确认子结构定位。

因为匹配后的离子用蓝色线画出，所以很容易与相应结构关联。

9. 复制图像，然后将其粘贴进一个绘图程序以增加线或其他特征。

使用相关 MS/MS 质谱

在有些应用中，很有用的一点就是能够对比改性化合物（如：代谢物）的质谱和前体化合物的
质谱和结构。

1. 使用 IDA Explorer 再次显示等值线图。 选择 668.2176/4.21 点对应的峰，然后隐藏等值
线图。

因为结构和碎片窗格已连接至质谱，所以为了反映新质谱窗格已更新，但是结构仍然表示的
是前体化合物，质谱是从带有额外氧原子的化合物（质量为 16 Da 以上）获得的。 很多情
况下，仍然有一些匹配，表明分子部分未改变，但是在本案例中，重要离子都没有匹配，也
没有用红色标出。

结构窗格含有一些简单的绘图工具，可对结构进行修改，以查看是否能找到任何匹配。

2. 结构窗格左侧含有一个带有元素符号的网格。 单击 O，然后将其朝主结构方向拖动。

当原子接近结构时，它以光标后的单键形式与结构结合。

3. 拖动 O 符号，这样键会被拖至结构（麦角灵）的下部，然后释放鼠标（例如：将新原子放
置在苯环上）。图 4-9 显示过程。

Explorer教程
57 / 105RUO-IDV-05-2906-ZH-B

使用结构工具



图 4-9 结构窗格

质谱再次更新后显示两个匹配项：668.2089 点的分子离子和对应于 588.2828 点上所丢失
HBr 的离子。这表明整体元素组成现在是正确的，但是事实却是主要碎片不匹配，这说明原
子未添加至分子的正确部位。

4. 单击刚刚添加的 OH 组，然后将其拖动至位于结构上部的吡咯烷环上。 确保只有被移动过
的原子以粗体绘出。 否则，表明整个高亮结构都移动了。

如图 4-10 所示，这会使 340.1927、366.1722 和 367.1797 点的离子形成匹配，相应结构
是与前体化合物的质谱相匹配的离子烃基化形式。
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图 4-10 溴隐亭质谱

前体质谱中出现了很多不匹配的低质量峰，或者是烃化等价物，它们是在当算法被允许打破
环键时匹配的，但是在 637.1725 处有一个高质量离子，可能是简单碎裂步骤中产生的，而
且尚未匹配。

5. 在 Fragments 选项卡中，选择 668.2089 对应的行，这样这一行会注上标记，而其他离子
会相对于它注上标记。

这表明 637.1725 点处的峰对应于前体分子（可能是 CH3NH2 或 CH3O）在 31.0364 点的损
失。由于前体分子质谱中未观察到该离子，所以这个离子极有可能是来自该结构环肽部分内
某一甲基的烃基化反应。

6. 在结构窗格内单击两次可取消选定结构，然后将新的 OH 基拖动至结构右侧的某一个甲基。

7. 打开 Fragment Options 对话框，将 Mass tolerance 设置为 30 ppm，然后单击 OK。

637 离子现在已匹配，选择碎片窗格中的这一行表明离子可能对应含甲氧基部分的损失。

8. 打开 Fragment Options 对话框，选择 Break ring bonds 复选框，然后单击 OK。

虽然当三个键（其中两个需用于前体分子，另一个为额外氧原子丢失）允许破裂时只有 209
处的离子可匹配，但是大部分碎片都可匹配。
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注意： 碎片窗格现在对有些质量包含多个行，如： 637.1905。每个行对应一个不同的可
能碎片（如果三个键都允许破裂，那么会生成更多碎片）。碎片窗格中的峰选项卡只显示
基于综合考虑（质量准确性、断键数、碎片是否是自由基等等）而被认为最佳的匹配。在
这种情况下，最佳匹配对应可能已为前体化合物生成但并未观察到的碎片，因此碎片选项
卡中的附加选项在提示不明显的潜在路径方面很有用。

摘要

本节中对下列任务进行了讨论：

• 以 .mol 格式的文件输入一个结构，然后将其与质谱连接。

• 选择部分结构，然后确定是否有相应的质量峰。

• 生成碎片窗格，然后设置参数以观察简单碎片。

• 使用 Fragments 和 Peaks 选项卡来显示匹配组成、子结构和质量峰。

• 修改 Fragment Options 以允许有更多复杂的碎裂途径。

• 在质谱窗格中加入子结构。

• 修改结构，探查相关分子的碎裂效应，如：代谢物。

通常，较好的做法是先从允许简单碎裂过程开始，根据需要选择额外碎裂选项（额外键、环
键），以便解释观察到的离子。 这与以下事实一致：离子碎片一般先形成更简单的碎片，然后
以一系列步骤碎裂，而不是通过协调步骤打破多个键。 当然，简单碎片可能不稳定，而且会立
即继续碎裂，所以可能观察不到。 另外，允许大量碎裂步骤要求更多的处理时间，也需要花更
长的时间来完成。

对比相关分子时，很有用的一点就是，叠加参考质谱（前体分子）和修改后的格式可能会很有
用，然后连接视图和结构或碎片窗格，活动质谱交换时窗格更新。 但是，如果重叠在一起时，
应用于已匹配和未匹配离子的配色可能难以区分，所以建议您在熟悉程序和视图前使用单个质
谱。
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虽然通常对单个样本有效，但有时候同时对比或肉眼观察多个样本时可能会获得更多信息。 本
节先对软件中可用于两个样本的一些可用工具进行描述，然后对可用于多个样本的工具进行了
描述。

操作两个样本

常用工作流是对比在不同条件下获得的两个样本，以确定有哪些变化。 例如，治疗药物管理后
的两个不同的时间点。 对比数据（T = 0 小时和 T = 1 小时）来自于将鼠肝微粒体注入血浆
后的溴隐亭温育。

开始前请关闭所有已打开的窗口。

1. 单击 File > Open Multiple Samples，然后浏览含有样本数据的文件夹。

2. 选择 Bromocrip_IDA-DBS in plasma_T=0.wiff 和 Bromocrip_IDA-DBS in plasma_T=1.wiff
文件，然后将文件拖动至窗口右侧。

3. 单击 OK。

图 5-1 选定多个样本

与打开分别显示测量和单独扫描的 TIC 的单个 IDA 文件相反，有多个 IDA 文件时，所有
样本的全部数据都会显示在单个 TIC 里。 在这种情况下，有两个 TIC，如图 5-2 所示。
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图 5-2 TIC

4. 单击 Show > Total Ion Chromatogram (TIC)，打开 Select Experiment 对话框。

5. 选择 Period 1, Experiment 1－TOF MS (100 - 2000)，然后单击 OK。

图 5-3 处理所有叠加对话框

处理叠加轨迹时会显示 Process All Overlays 对话框，用户可选择是否处理所有轨迹或只
处理活动轨迹。 处理所有轨迹非常有用，这是因为接下来的操作会影响所有轨迹（样本）。

6. 选择 All Overlaid。
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7. 选择 Only show the dialog again if the shift key is down 复选框，使这个选择成为
默认操作。

8. 单击 OK。

可生成一个含有测量 TIC 叠加的窗格。色谱法的重复性非常好且代谢产物峰也较密集，因
此有些可通过缩放和对比色谱图找到（检查 6 分钟左右的区域），但是通常需要进行额外
的工作。有很多方法可生成更易对比的视图。 在这个例子中，使用了基峰色谱图。

注意： 如果单击了 File > Open Heat Map TICs from Wiff，则可直接生成条形视图，而
无需先显示叠加的色谱图。

9. 隐藏原 TIC 窗格，然后单击 Show > Base Peak Chromatogram (BPC)。

10. 在 BPC Options 对话框中，按需要修改设置以匹配 图 5-4 中的值，然后单击 OK。

图 5-4 BPC Options 对话框

基峰色谱图是各扫描中最大峰的强度随保留时间变化的曲线图。 为了提供更多信息，当基
峰质量的变化量超过本对话框中规定的质量允差时，各轨迹可在其正常颜色与灰色之间切
换。

或者，您可以对所考虑的质量范围作出限制（例如，这样可以避免噪声背景峰导致的人工痕
迹）并设置保留时间范围以加速处理。 因为我们知道溴隐亭的质量约为 652，简单代谢产
物的 m/z 比不会低于 500。

11. 在 Process All Overlays 对话框，确保选定 All Overlaid 选项，然后单击 OK。

与原来的 TIC 相比，在新窗格中显示 BPC 更简单且更容易对比。
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图 5-5 BPC

与 T = 0 样本（蓝色）相比，在 1 小时样本中似乎有两个峰（粉红色）在减小。 它们对
应溴隐亭（6.09 分钟） 和一种同分异构物。 还有三个峰（蓝色箭头）只出现在了 T = 1
样本中，但没有出现在 T = 0 样本中。 它们可能是潜在代谢产物。

注意： BPC 可能会非常有用，但是它只能反映最强离子的变化（在选定的质量范围内）。
不会变为基峰的质量峰可能不会显示出来，所以如果想要查看样本之间的差异需要使用其
他工具。

12. 隐藏 TIC 窗格。

13. 在 BPC 内的 6.09 分钟处双击

14. 在 Process All Overlays 对话框中选择 All Overlaid，然后单击 OK。

这样可生成两个叠加质谱。

15. 在质谱窗格中，单击然后缩放，以显示 m/z 比约为 652 时的同位素群集。 请参阅 图
5-6。
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质谱窗格中含有来自两个样本的叠加质谱，因此容易对比。在这个例子中，很明显 T = 1
hr 样本（粉红色）中的强度小于 T = 0 样本。

在查看像这样的高分辨率数据时，概览图非常有价值，这是因为它可以提供一种方式，在保
持全部质谱可见的同时查看详情。

图 5-6 m/z 比约为 652 时的同位素群集

16. 在色谱图窗格中，在显示质谱时间的线（先前已双击）上移动光标。

17. 当光标变为双箭头时，将其拖动至约为 5.8 分钟对应的峰。

质谱继续显示扩展的质量范围（现在只有噪声和小峰）。 如要在主窗口中显示粉红色大峰，
可拖动概览图内黑色箭头指示的的粉红色矩形。 释放鼠标后视图恢复正常。

在 图 5-8 中，勾选了“标记所有叠加轨迹”图标。
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图 5-7 BPC 和质谱
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图 5-8 BPC 和质谱，应用了标记所有叠加轨迹选项

T = 0 样本中没有这些峰。

18. 继续操作前请关闭所有窗口。

操作两个以上的样本

当叠加两个以上的样本时，窗口可能会变得混乱，这会使得更难将差异与正确样本关联起来。
软件中含有其他工具，可帮助显示来自多个样本的数据。

示例中使用的数据集来自六个不同数据集的杂质剖面分析。

1. 单击 File > Open Multiple Samples。

2. 选择 DataSet61.wiff 至 DataSet66.wiff 文件，然后将其移动至 Selected 面板。

Explorer教程
67 / 105RUO-IDV-05-2906-ZH-B

对多个样本有效



图 5-9 选定的多个样本

3. 单击 OK。

4. 单击 Show > Total Ion Chromatogram(TIC)。

5. 从 Select Experiment 对话框中选择 Period 1, Experiment 1。
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图 5-10 Select Experiment 对话框

6. 单击 OK。

7. 在 Process All Overlays 对话框，选择 All Overlaid，然后单击 OK。 表中显示了文件
中各样本的 TIC 色谱图叠加。
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图 5-11 DataSet61.wiff 至 DataSet66.wiff 中实验 1 的叠加 TIC

活动轨迹的标题以粗体字显示。 单击这个标题左侧的图标可将标题折叠到一行，以便为信
息提供更多空间。

8. 单击 Show > Overlaid Traces as Heat Map，然后在生成的窗格中设置颜色控制，即：设
置 min% 为 0.5，max% 为 100。

提示！ 如果颜色控制不可见，则单击右键，然后选择 Show Appearance Control。

9. 单击色谱图窗格里面，然后单击“隐藏所有其他窗格”图标。
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图 5-12 热图色谱

每个样本都由一个根据强度进行颜色编码并可显示其 TIC 的单水平条带表示。 根据上述配
色方案，黄色表示未采集到数据的点或强度小于样本最大强度 0.5% 的点，蓝色表示 0.5%，
红色表示最大强度信号。

该窗口显示 6 - 7 个峰（4.5 - 6.5 分钟），除了 6.5 分钟处的峰之外，其他峰的响应情
况存在差异。

峰的顺序与样本的采集顺序相同，但可能不是最理想的。 在此例中，这个顺序是适合的。

10. 在窗格中单击右键，然后单击 Show Samples Table。 最初，样本表在热图右侧。 窗格右
上角的“拖动并重排窗格”图标 可用于将窗格拖放至热图底部，以将表移动至原窗格下方。
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图 5-13 热图色谱的样本列表

表中含有与各样本相关的不同文本字段列。 Display Name 列可编辑，但其他列只读。 所
有列都可用于分类表和样本视图。

11. 在 5.5 分钟左右的 Imp STD 10 中进行选择，然后在其内部双击。

一个新的热图质谱窗格即会生成，完整的质量范围显示在 X 轴上。
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图 5-14 热图质谱

根据质谱图可确定，有几个质量（介于 m/z 400 和 m/z 460 之间）是造成所选时间区域内
强度更高的原因。

12. 选择 Imp STD 10 样本的 Mass/Charge Da 值为 401 左右时的质量，然后右击选择 Show
Spectra for Selected Samples。

这样即可生成选定样本的质谱。 可显示某一时间点的质谱。 请参阅图 5-15。

13. 双击热图质谱中 Mass/Charge Da 为 401 时的质量，以生成一个热图 XIC。

Explorer教程
73 / 105RUO-IDV-05-2906-ZH-B

对多个样本有效



图 5-15 质谱

摘要

本节中对下列任务进行了讨论：

• 使用软件内可用的多个样本工具。

• 用叠加色谱图和交互质谱对比两个样本。

• 用热图视图对比多个样本。
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本节对软件中的 Bio Tool Kit 菜单项下的一些可用选项进行了描述。

注意： 必须激活 Bio Tool Kit MicroApp Feature 才能使用这个功能。 激活完成前，可用
的选项只有 Peptide Fragments、Add Manual Reconstruct Highlights 和 Remove Manual
Reconstruct Highlights。 请参阅发行说明文件中的 Activate the Bio Tool Kit MicroApp
Feature。

手动排序

通过该选项可对消化后的蛋白样本的 MS/MS 质谱数据进行手动排序。

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_digests.wiff 文件，然后单击 OK。

Open IDA Sample 对话框即会打开。

图 6-1 Open IDA Sample 对话框

4. 确保选定 With the IDA Explorer 选项，然后单击 OK。

Explorer教程
75 / 105RUO-IDV-05-2906-ZH-B

6使用 Bio Tool Kit 功能



图 6-2 来自 RP_digests.wiff 的质谱

5. 单击 Table 标签。

6. 在 Time 12.73 处选择 m/z 471.2398。

7. Spectrum 窗格打开后，单击 Graph > Duplicate Graph。

针对所选定前体 (471.2) 的新 Spectrum 窗格即会打开。 IDA Explorer 窗格及其相关
Spectrum 窗格可删除。
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图 6-3 保留时间为 12.73 和前体为 471.2398 时的质谱

8. 选择标记为 738.3833 的峰。

9. 单击 Bio Tool Kit > 手动排序。

Sequence Options 对话框即会打开。
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图 6-4 Sequence Options 对话框

注意： 当选择 Ignore isotopes 和检查电荷状态复选框后，在软件提议接下来的氨基酸
时就不会考虑同位素和电荷状态不正确的峰。

10. 单击 OK。

Create Sequence 对话框即会打开。
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图 6-5 Create Sequence 对话框

注意： 通过这一对话框，用户可在对文件进行手动排序后更改针对 y- 和 b- 系列图标所
做的假定并查看哪一个假定与数据最符合。

11. 确保选定 Create Sequence (for Peptide Fragments Pane) 复选框。

12. 在 Precursor charge 字段中键入 2。

13. 在 Fragment charge 字段中键入手动排序时应追踪的选定峰的电荷值。

14. 单击 OK。

软件更新后可显示更新后的 Spectrum 窗格和能指出质谱数据上可能获得或丢失的第一组氨
基酸的红色垂直线。
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图 6-6 手动排序的质谱－最初的可能情况

15. 双击应进一步排序的红色垂直线的标题。

软件更新，指示质朴数据上的下一组氨基酸。

16. 重复步骤 15，直到所有可能的氨基酸均已提出为止。
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图 6-7 手动排序的质谱

注意： 中 在图 6-7 中，按照以下顺序单击标题：F > G > I/L > E > Y。

提示！ 如果软件提出一个以上的可能情况建议，而且您想选择一条不同于最初建议的分支
时，可从图返回至主视图并重复该程序，选择相应的替代氨基酸标签。

手动排序，与肽碎片相连

1. 单击 Bio Tool Kit > Peptide Fragments。

Peptide Fragments 窗格即会打开，并与手动排序的质谱相连接。
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图 6-8 Peptide Fragments 窗格，与手动排序的质谱相连接

注意： 匹配实验数据的氨基酸在 Table 选项卡的列中以红色粗体字显示。 匹配实验数据
但是有不同的目标碎片电荷的氨基酸在 Table 选项卡的列中以红色斜体字显示。

2. 单击 List 选项卡。

3. 单击 Show > Mass Calculators。

4. 单击 AA Property 选项卡。
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图 6-9 质量计算器－AA Property 选项卡

注意： 默认情况下，质量计算器会自动连接至手动排序后的质谱。 质谱中的氨基酸序列
显示在 AA sequence 字段中。

5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Set Sequence Creation Parameters。

Create Sequence 对话框即会打开。
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图 6-10 Create Sequence 对话框

6. 如下完成 Create Sequence 对话框：

• 确保选定 Create Sequence (for Peptide Fragments Pane) 复选框。

• 选定 Assume b-series 选项。

• 在 Precursor m/z 字段中输入 471.2398。

• 在 Precursor charge 字段中键入 2。

• 在 Fragment charge 字段中键入 1。

7. 单击 OK。

Peptide Fragments 窗格和 Mass Calculators 窗格更新已升级的序列数据。

8. 单击 Peptide Fragments 窗格中的 Table 选项卡。

教程Explorer
RUO-IDV-05-2906-ZH-B84 / 105

使用 Bio Tool Kit 功能



图 6-11 更新后的 Peptide Fragments 窗格，与手动排序后的质谱相连接

9. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Clear Manual Sequencing。

清除所有手动排序标记。

添加和删除手动重构高亮

通过 Add Manual Reconstruct Highlights 选项，将指示给定质量的理论 m/z 位置的标记添
加至质谱中。在确认当质谱含有多电荷成分时质谱内的特殊峰是否对应相同成分的情况下，该
功能非常有用。通过 Remove Manual Reconstruct Highlights 选项去除标记。

提示！ 拖动标记的垂直线至一个新的 m/z 值，进而将标记移动至一个新位置。

提示！ 单击标记的垂直线或相应的电荷状态标记，以使标记处于活动状态。活动标记显示
m/z 位置。

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_Intact.wiff 文件，然后单击 OK。
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图 6-12 来自 RP_Intact.wiff 文件的 TIC

4. 使用肌红蛋白峰峰顶部区域（5.91 至 6.00 分钟）创建一个平均质谱。

图 6-13 平均质谱
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5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Add Manual Reconstruct Highlights。

Add Manual Reconstruct Highlights to Graph 对话框即会打开。

图 6-14 添加手动重构高亮至图

6. 在 Value 字段中键入 16950。

7. 选择 H+ 作为电荷调节剂，然后单击 OK。

图更新后含有高亮。

图 6-15 带有新增高亮的质谱

8. 单击 Bio Tool Kit > Remove Manual Reconstruct Highlights 去除标记。

图更新后高亮去除。
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消化蛋白质

通过这个选项获取来自于用户针对特定蛋白质而自定义获得的酶法分析产物的理论肽序列的信
息。

工具栏

使用工具栏内的图标，按需要调整视图。

表 6-1 工具栏图标

名称（工具提示）图标

按序列查找和替换

将选定部分转换为大写字体

查找序列

注意： 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工
具栏。

按序列查找和替换

通过该选项查找 Sequence（序列）字段中的现有文本并用新文本替换。

1. 单击“按序列查找和替换”图标。

Find and Replace Text 对话框即会打开。

图 6-16 Find and Replace Text 对话框

2. 在 Find 字段中键入要替换的信息。

3. 在 Replace 字段中键入适当的信息。

4. 单击 OK。
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用用户规定的替换文本替换软件中的现有文本。

将选定部分转换为大写字体

通过该选项将用小写字体键入 Sequence 字段中的文本转换为大写字体。

1. 选择适当的文本。

2. 单击“将选定部分转换为大写字体”图标。

软件可用大写的文本内容替换小写的相同文本内容。

查找序列

通过这个选项可查找 Sequence 字段中的文本。

1. 单击“查找序列”图标。

Find Text 对话框即会打开。

图 6-17 查找文本对话框

2. 在 Find 字段中键入适当的信息。

3. 单击 OK。

软件可突出显示匹配文本。

理论蛋白质消化

1. 单击 Bio Tool Kit > Digest Protein。

Protein 窗格即会打开。
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图 6-18 蛋白质窗格－蛋白质和肽选项卡

2. 在所提供的字段内输入一个蛋白质或肽序列。

注意： 本教程使用的是 GLSDGEWQQV LNVWGKVEAD IAGHGQEVLI RLFTGHPETL EKFDKFKHLK
TEAEMKASED LKKHGTVVLT ALGGILKKKG HHEAELKPLA QSHATKHKIP IKYLEFISDA IIHVLHSKHP
GDFGADAQGA MTKALELFRN DIAAKYKELG FQG（肌红蛋白序列）。

3. 选择 Enzyme。

注意： 本教程中选择的是胰蛋白酶。

4. 选择 Max. missed cleavages。

注意： 本教程中选择的是 0。

5. 单击 Digest。

软件将关于酶解肽及其序列的理论信息填入表中。
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图 6-19 蛋白质窗格，填有理论信息

6. 单击 Variable Modifications 选项卡。
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图 6-20 蛋白质窗格－变量修改选项卡

7. 选择 Max. number of simultaneous modifications。

注意： 本教程中选择的是 3。

8. 勾选 Use 列中的复选框，以进行恰当修改。

提示！ 如果图标显示在复选框左侧，那么整个氨基酸列表都可选定或可选定那些适用项。

注意： 本教程中选定的是 [1Ac] 的复选框。
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图 6-21 选定修改示例

9. 单击 Protein & Peptides 选项卡。

10. 单击 Digest。

表中的结果经过修改后可反映用户所做的选择。
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图 6-22 蛋白质窗格，填有修改后的信息

LCMS 肽重构

通过 LCMS 肽重构来确认质谱峰并对已确认的质谱峰进行去卷积。 LCMS 肽重构工具含有两个
操作步骤。 首先，使用强化型峰发现算法找到峰。 其次，该工具可找到形成同位素系列和电
荷系列的峰组并报告所发现所有组分的中性质量。

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_digests.wiff 文件，然后单击 OK。

Open IDA Sample 对话框即会打开。
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图 6-23 Open IDA Sample 对话框

4. 确保选定 As a standard TIC 选项，然后单击 OK。

确保第一个轨迹 IDA Survey from RP_digests.wiff (sample 1) - Sample001 以粗体显
示。 必要时可选择这个轨迹。

图 6-24 IDA Survey from RP_digests.wiff

5. 单击 Bio Tool Kit > LCMS Peptide Reconstruct (with peak finding)。

LCMS Peptide Reconstruct Options 对话框即会打开。
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图 6-25 LCMS 肽重构选项对话框

6. 在提供的字段内键入下列值：

• 在 Minimum retention time 字段内输入 9.00 分钟

• 选择 Maximum retention time 复选框，然后在字段中键入 16.00

• 在 Approximate LC peak width 字段中键入 6.0 秒

注意： 峰宽近似值用于确定背景减除期间的偏移。

• 在 Minimum intensity in counts 字段中键入 5 个数

• 在 Chemical noise intensity multiplier 字段中键入 1.5

• 在 Mass tolerance 字段中键入 0.100 Da

• 在 Maximum charge 字段中键入 5

注意： ‘电荷去卷积’一节中的质量允差可确保重构峰与理论上消化的蛋白质相匹配，并
确保术语相同蛋白质的不同 m/z 值组合在一起。

7. 单击 OK。

软件可显示按保留时间区分的肽列表。 列表中的每个肽都有下列信息：Index、Ret. Time、
Mass、Mass / Charge、Int. Sum 以及 Num. Peaks。
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图 6-26 重构峰列表

8. 展开 Filtering 以显示可用的过滤选项。

可用的过滤选项包括：Intensity threshold 、Min. Num. Peaks 和 Show matched peaks
only。
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图 6-27 过滤选项

9. 选择一个或多个过滤器，按需要调节视图。

注意： 在本教程中，Intensity threshold 设置为 2.39e4，Min. Num. Peaks 设置为
4。

图 6-28 过滤后的重构峰列表

工具栏
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使用工具栏内的图标，按需要调整视图。

表 6-2 工具栏图标

名称（工具提示）图标

显示质谱和 XIC

显示 IDA MS/MS 质谱

注意： 关于该工具栏中的最后六个图标的描述（从“删除窗格”图标）开始，见通用窗格工
具栏。

显示质谱和 XIC

当选定“显示质谱和 XIC”图标时，下列质谱和 XIC 窗格即会打开：

图 6-29 显示质谱和 XIC 结果

对于生成的 MS 谱图，导致肽质量的各峰下方会显示一个箭头。 每个导致肽质量的 m/z 峰的
XIC 在窗格右侧显示为叠加物。

显示 IDA MS/MS 质谱

当选定“显示 IDA MS/MS 质谱”图标后，下列质谱窗格即会打开：

用消化蛋白质重构 LCMS 肽

1. 单击 Bio Tool Kit > Digest Protein。
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Protein 窗格即会打开。

2. 将 Protein 窗格内的“拖动至蛋白质窗格以设置其峰列表”图标拖动至 Reconstructed
Peak List 窗格内。

Protein 窗格更新后显示蛋白质窗格内与重构峰列表相匹配的肽序列。 Protein 窗格中以
红色粗体显示的的碎片是与 Reconstructed Peak List 窗格形成精确匹配的碎片。 以红色
普通字体显示的碎片表示可能已与 Reconstructed Peak List 窗格内的碎片形成匹配的碎
片，但前提是 Reconstructed Peak List 窗格的 Match 列中的括号内已指定了碎片的电荷
状态。 以黑体字显示的碎片指与 Reconstructed Peak List 窗格内的任何碎片都不匹配的
碎片。

图 6-30 关于与重构峰列表相连接的蛋白质窗格的理论信息

教程Explorer
RUO-IDV-05-2906-ZH-B100 / 105

使用 Bio Tool Kit 功能



重构蛋白质

通过这个选项获取一个完整蛋白质的平均质量（分子量）。

1. 单击主工具栏中的“打开样本”图标。

Select Sample 对话框即会打开。

2. 如果 Sample Data 文件夹未选定，则单击 Browse 并前往 Sample Data 文件夹。

3. 选择 RP_Intact.wiff 文件，然后单击 OK。

图 6-31 来自 RP_Intact.wiff 文件的 TIC

4. 使用 5.93 分钟时的峰区域创建一个平均质谱 请参阅图 6-32。
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图 6-32 平均质谱

5. 当质谱窗格处于活动状态时，单击 Bio Tool Kit > Reconstruct Protein。

Reconstruct Options 对话框即会打开。

图 6-33 重构选项
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6. 为以下选项输入恰当的值：

• 开始质量：15000 Da

• 停止质量：18000 Da

• 步骤质量：1.0 Da

7. 选择恰当的 Input spectrum isotope resolution：中度 (10000)。

注意： 对于通过四极杆系统获取的数据，显示的是峰宽参数，而不是输入质谱同位素分辨
率参数。

8. 选择恰当的 电荷调节剂：H+。

9. 单击 OK。

软件在单独的窗格中生成一个重构蛋白质的质谱，标题为：Reconstruction, Input spectrum
isotope resolution [user selection]。

图 6-34 重构窗格

Explorer教程
103 / 105RUO-IDV-05-2906-ZH-B

使用 Bio Tool Kit 功能



注意： 对于通过四极杆系统获取的数据，窗格内的标题为：Reconstruction，Peak width
[value]。

10. 选择重构的蛋白质峰。

垂直手动重构高亮被添加至选定用于生成重构蛋白质的质谱中。

图 6-35 质谱，带有手动重构高亮

摘要

本节中对下列任务进行了讨论：

• 对消化后的蛋白样本的 MS/MS 质谱数据进行手动排序。

• 连接手动排序的质谱和肽碎片。

• 将指示给定质量的理论 m/z 比的标记（手动重构高亮）添加至质谱中。
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• 从质谱中移除标记。

• 获取来自于用户针对特定蛋白质而自定义获得的酶法分析产物的理论肽序列的信息。

• 通过 LCMS 肽重构来确认质谱峰并对已确认的质谱峰进行去卷积。

• 连接关于蛋白质窗格的理论信息和重构的峰列表。

• 获取完整蛋白质的平均质量（分子量）。
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